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September Luncheon Meeting
Wednesday, September 13th, 12:00 p.m.

Ortiz Convention Center
402 Harbor Drive

Speaker: J. A. “Tony Canales
Topic: To Be Announced

CLE Credit: To Be Announced

Cost: $16.00 per person for members, $21.00 per person for non -members if reserved
by noon, Tuesday, September 12th, 2006. Call the Bar Office at 883 -4022 to RSVP
or e-mail us at sgonzales@corpusbar.com. All reservations must be paid for. “No

Shows” will be billed. The cost at the door will be $18.00 for members, $23.00 for non -members.

 NOTE 
ADDED ADVANTAGE OF ADVANCE RESERVATIONS — THOSE WHO RSVP IN AD-
VANCE WILL HAVE THEIR CLE ATTENDANCE CARDS PRE -POPULATED SO ALL THEY
HAVE TO DO IS TO SIGN THE CARD (AND, OF COURSE, STAY FOR THE PRESENTATION)
IN ORDER TO OBTAIN THEIR CLE CREDIT — Just another service of your Corpus
Christi Bar Association
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Metadata – The Hidden
Electronic Threat to

Attorney-Client Confidentiality

You would never tell opposition about
conversations or strategy that could hurt
the firm or its clients. Likewise, you
would never give a computer hacker a
roadmap for where to place macro vi-
ruses on your computer or network.
Unfortunately, the simple act of creating
documents in Word and WordPerfect
can give away valuable information such
as this without your even knowing about
it. You do this through metadata.
“Metadata” is “data on data.” What this
means to you is that every time you
open, edit, or save a document, extra
data is stored within the electronic ver-
sion of the document. This “metadata” is
used to enhance a document in a variety
of ways, including storing file information
on who created or edited the document,
as well as when and where the docu-
ment was saved. Even though metadata
was designed to enhance your docu-
ment, it can also inadvertently share
confidential information with others.

Metadata exists in many software appli-
cations, but the major concern for law-
yers is the information left behind in the
electronic version of documents pre-
pared with word processing software
since court filings, agreements, and
merger and acquisition documents, to
name a few, are frequently shared in
electronic format.

Most document producing software em-
beds metadata within documents as the
files are created and edited. For exam-
ple, the names of past and present au-
thors, and the time spent editing the

document, even the e-mail address of the
person sending the document through e-
mail can be embedded. Knowing what
metadata resides in your documents and
removing the information can mean the
difference between accidental disclosure
or even malpractice and safeguarding
your information.

Microsoft Word (and Excel and Power-
Point), WordPerfect, and PDF documents
contain metadata. Some types of meta-
data are benign and useful while other
types can provide others who view or
work on your documents with information
you may not want them to know. Unless
removed, metadata travels with the docu-
ment.

Metadata includes the following that can
be found in Word and WordPerfect docu-
ments: authors, firm name, file location,
file properties, versions, tracked changes,
comments, hidden text, hyperlinks, styles,
headers and footers, linked objects, small
font, and matching font.

In Word documents you also can find fast
saves, time spent in editing, and embed-
ded objects.

In WordPerfect documents you also can
find “Undo/Redo” history and non-visible
portions of embedded OLE objects.

PDF files can contain authors, create
data, filename, PDF version, page count,
encryption status, permanent ID, chang-
ing ID, producer, creator, custom fields,
title, subject, keywords, modification date,
bookmarks (total number), and annota-
tions (total number, type, and total type
amount).

New York has issued an ethics rule ad-
dressing electronic sleuthing which states
that “Lawyers may not ethically use avail-

“Name” and “Initials” boxes. Unfortu-
nately, the time and date that the com-
ment was made is not removed even
when this option is configured. The
“Undo/Redo” option in WordPerfect
saves and stores historical information
about edits made in the document. To
disable this feature, from the “Edit” menu,
choose “Undo/Redo History.” Click
“Options” and disable the “Save Undo/
Redo Items with document” by removing
the check mark from the box. Click “OK,”
and then “Close.” To remove summary
details, from the “File” menu, choose
“Properties” and select the “Summary”
tab. Remove from the boxes displayed
the descriptive name, type, creation date,
author, and other information that you do
not want saved with the document.

Minimizing Word Metadata
Word 2002 and 2003 contain security
options that are designed to remove
some embedded metadata and show
whether track changes or comments
exist in a document. To display and con-
figure these options, from the “Tools”
menu, choose “Options” and select the
“Security” tab. Check “Remove Personal
Information From File Properties on
Save.” When that entry is checked, most
of the information in the “File Properties”
dialog box is removed, as are the last ten
authors and the file path where the docu-
ment is stored. Check “Warn Before
Printing, Saving Or Sending A File That
Contains Track Changes Or Comments.”
When checked, this option forces Word
display a warning when a document con-
taining tracked changes or comments is
being saved, sent, or printed. You
should also check the box for “Make Hid-
den Markup Visible When Opening Or
Saving.” If a document contains markup
and the “Reviewing” toolbar filter is set to
“Final” or “Original,” this security option
forces the changes to be visible on Open
or Save. Unfortunately, these three set-
tings only remove or identify a small set
of the potential metadata in a document.
Adapted from articles by Donna Payne of
Payne Consulting Group

able technology to surreptitiously exam-
ine and trace e-mail and other electronic
documents. Opinion 749 – 12/14/01:
Code: DR 1-102(A)(4), DR 1-102(A)(5),
DR 4-101, DR 7-102(A)(8), Canon 4,
Canon 7, EC 4-1. To date, Texas has
issued no rules nor any ethics opinions
specifically addressing mining of meta-
data; but the principles governing the
inadvertent discovery of confidential ma-
terial may apply.

The existence of metadata raises three
questions:

1. Do lawyers have a duty to warn clients
of the metadata risk?

2. Do lawyers have any kind of duty, in
"zealously representing the interests of
their clients," to look at the metadata in
INCOMING documents?

3. If clients are warned, how do lawyers
handle the public relations challenge of
explaining why it has taken so long to
bring this to light?"

Protecting your clients and practice from
accidental disclosure is something of
which all need to be cognizant. There
are two ways to reduce the amount of
metadata stored in your documents. You
can buy a third-party software designed
to remove it, or you can print a document
and then scan it into PDF. There are
ways to reduce the risk without taking
either of those steps.

Minimizing WordPerfect Metadata
Corel has published an article about how
to minimize metadata in WordPerfect
(www.support.corel.com and search
“minimizing WordPerfect metadata”).
Here are some steps you can take. You
can remove a comment by right-clicking
on it and clicking “Delete” in the box that
appears or by viewing reveal codes and
dragging the comment code out of the
reveal codes window. To prevent com-
ments from containing metadata, from
the “Tools” menu, choose “Settings,” and
then “Environment.” Select the “General”
tab, and delete the information from the
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A +-2,562 SF office building
with 7 offices & conference
room. Re-modeled in 2003 &
2005 to “Architectural Digest”
quality!
Offered at $235,000

A +-9,200 SF retail building
which is easy to convert to of-
fices or cubicle stations. Excel-
lent visibility for advertising
your firm!
Offered at $310,000

Both properties may
qualify for HUD
Community Rein-
vestment Zone tax

credits.

STEVE ROBERTS REALTY ASSOCIATES
Call...Jim Villaume, CCIM, MAI

361-993-1125 or 688-1987

THE VERDICT IS IN . . .
Great Uptown Office Locations

within two blocks of the Courthouse!

413 N. Tancahua 1024 Leopard St.

Donald M. Feferman
J.D., C.P.A.

Attorney At Law
Wharton School of Business,

University of Pennsylvania-1962
Harvard Law School-1965

Helping Businesses Solve Their Legal Problems
Since 1967

Commercial and Securities Arbitration
Commercial Organizations and Transactions

Real Estate Transactions

361-883-1830
800-966-1830

1450 Wells Fargo Tower
Corpus Christi, Texas 78477

don@feferman.com
http://www.fefermanlaw.com
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BAKER & BAKER
BRENDA B. BAKER EDWIN W. BAKER*

Guardianship

Medicaid Eligibility

Wills • Probate & Elder Law
Special needs trusts

Miller trusts • Asset Protection

Corporations

(361) 985-2226 phone
5350 SOUTH STAPLES • SUITE 106
CORPUS CHRISTI, TEXAS 78411

*MEMBER, National Academy of Elder Law Attorneys, Inc.™

CCBA Dues Were Due July 1st
Have you paid your 2006 — 2007 dues
yet? The new year started July 1st.
Please check your records. If you have
any questions whether your dues have
been paid, please call Dick King at 883-
4022 or e-mail him at
dking@corpusbar.com. Individuals who
have not paid their dues by Septem-
ber 30th will be dropped from the
CCBA membership rolls. They will no
longer receive blast e-mails, copies of
the newsletter, nor discounted prices for
seminars and luncheon CLE, and they
will be deleted from the Pictorial Direc-
tory next year.

CCBA Board Actions
The CCBA Board met August 19th and
took the following actions:

Agreed that members who had not paid
their dues by September 30th would

be dropped from the rolls.
Agreed to hold a raffle for a free lunch or

a copy of the Pictorial Directory
Formed a committee to review the

bylaws to see if modifications are
Necessary

Mark Your Calendars
Bold indicates seminar or new entry on
the calendar

September
1 — Office Closed for installation of

membership software
4 — Holiday, Office Closed
13 --- Luncheon, 12:00 p.m., Ortiz

Center
14 - 15 — SBOT Board of Directors

Meeting at Omni Bayfront
16 — Drop of unpaid members from

the membership rolls
26 — Board of Directors Meeting

October
Annual "Coat, Blanket, and Warm

Clothing Drive" begins

4 — Red Mass, Judge Carolyn
Dineen King, 5th Circuit Court of
Appeals

11 --- Luncheon, 12:00 p.m., Ortiz
Center

24 — Board of Directors Meeting,
27 — Advanced Personal Injury

Seminar

November
"Coat, Blanket, and Warm Clothing
Drive" ends and donations distributed
to homeless shelters; "Adopt a Family"
Holiday Project begins
8 --- Joint Luncheon with Legal Pro-

fessionals, 12:00 p.m., Ortiz Center
10 — Holiday, Office Closed
18 — Peoples Law School
23 — Holiday, Office Closed
24 — Holiday, Office Closed
28— Board of Directors Meeting

December
"Adopt a Family" Holiday Project ends
and food and other donated items dis-
tributed to “adopted” families; Judges’
Fish Fry
22 — Holiday, Office Closed
25 — Holiday, Office Closed

January 2007
1 — Holiday, Office Closed
10 — Luncheon, 12:00 p.m., Ortiz

Center
15 — Holiday, Office Closed
23 — Board of Directors Meeting

February 2007
Mock Trial
14 — Joint Luncheon with CPA’s,

12:00 p.m., Ortiz Center
27 — Board of Directors Meeting

March 2007
Nominating Committee, Docket Call,

12 — 16 CCISD Spring Break
7 —- Coastal Bend Women

Lawyers Association Luncheon
27 — Board of Directors Meeting

April 2007
Election of New Board, Advanced

Civil Trial Law Seminar
2 — Passover Begins

6 — Good Friday,
8 — Easter
11 — Annual Meeting Luncheon,

12:00 p.m., Ortiz Center
24 — Board of Directors Meeting

May 2007
Criminal Law Seminar
3 — Law Day Reception, 5:30 p.m.—

7:30 p.m., Ortiz Center
4 — Law Day Luncheon, 11:30 a.m.,

Ortiz Center, Judge Carl E. Stewart,
5th Circuit Court of Appeals

22 — Board of Directors Meeting
28 — Holiday, Office Closed

June 2007
Docket Call, Baseball with the Bench,
State Bar Annual Meeting
26 — Board of Directors Joint

Meeting with new Board

CCBA New Members
We welcome the following new mem-
bers:

Bruce L. Collins, III , phone 883-3006

Mikhal Gongora , who has joined the
Law Office of James B. Ragan

Kirby D. Hopkins, who is with Drucker,
Rutledge & Smith L.L.P., phone(281)681-
3515

Robert S. Nichols , who is with Brace-
well and Giuliani, L. L.P., phone (713)
221-1259

Linda Rhodes-Schauer, phone 884-
2800

N. J. Welsh, III, phone 883-1704

Actually Said In Court
Attorney: This myasthenia gravis, does it
affect your memory at all?
Witness: Yes
Attorney: And in what ways does it affect
your memory?
Witness: I forget
Attorney: You forget? Can you give us
an example of something you forgot?
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Additions:
Pg. 23 – Collins, Bruce L., III
(Catharine)
1610 Wells Fargo Tower (78477)
Office, 883-3006
Fax, 884-2998

Pg. 31 – Gongora, Mikhal
Law Office of James B. Ragan
723 Coleman Ave. (78401)
Office, 884-7787
Fax, 884-9144
E-Mail, gongora76@aol.com

Pg. 37 – Hopkins, Kirby D.
(Jennifer)
Drucker, Rutledge & Smith, L.L.P.
10003 Woodloch Forest Dr., Ste. 225
The Woodlands, TX 77380
Office, 281-681-3515
Fax, 281-681-3543

Pg. 47 – Nichols, Robert S.
Bracewell & Giuliani LLP
Pennzoil South Tower
711 Louisiana, Ste. 2300
Houston, TX 77002
Office, 713-221-1259
Fax, 713-222-3269
E-Mail, bob.nichols@bracewellgiuliani.com

Pg. 52 – Rhodes-Schauer, Linda
(Don)
615 N. Upper Broadway, Ste. 2000 (78477)
Office, 884-2800
Fax, 884-2822
E-Mail, lrhodes-schauer@sbcglobal.net

Pg. 61 – Welsh, N.J., III
426 S. Tancahua (78401)
Office, 883-1704
Fax, 883-0129

Corrections:
Pg. 30 – Garza, G. Rudolph, Jr.
E-Mail, rgarza@davlin.net

Deletions:


